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Motion control

Ethernet Smoothstepper

Converts commands from Mach4
into stepper motor pulses.




Set up PC

Mach4 requires a PC running Windows 10 or 11. Use common windows setup, no
extra software is needed, or desired, this PC should only be used as a machine
control.

Install Mach4 from memory stick, Or download file from downloads tab at
https://machsuspport.com

Also requires a plugin from Warp9 tech on the memory stick or Download from
https://warp9td.com



Documents

Mach4 provides many manuals when installed
C:\Mach4Hobby\Docs

The ESS has many pages of on-line documentation
https:\\Warp9td.com

This document is a simplified guide to the installation.

If questions arise see the above sources.



Mach4 Profile

A PC can be setup to run several different machines.

Each machine has a separate configuration appropriate to that machine.

The configuration is saved in a folder C:\Mach4Hobby\Profiles

When installing Mach4 you will be asked for a profile. Create a meaningful name.
In the sample screens here we used MyLathe as profile name.

DO NOT use one of the system profile names, it will be overwritten if you upgrade
the software.



Optional profile

We have provided a profile suitable for the LMS 5100
We called it MyLathe.

A copy is on the memory stick.

Copy the file from the stick and put it in the profile folder.
C:\Mach4Hobby\Profiles

All of the following configuration steps are completed in this profile.



& MachdMill Properties *

. Security Details Previous Versions
PrOflle (2) General Shortcut Compatibility
@ Mach4Mill
The Mach4 install will create some Target type:  Application
desktop ICOﬂS Target location: Mach4Hobby
Target: [E-WochaHobby\achdGUI exe /o Nachanulj
Right click on the icon for Mill. | N
Start in: |C:'-.Mad14Hnbb:.' \
\
Select Properties Shottout key: [None
. . Bun: Momal window ~
The Target line will have the start e

command for Mach4, followed by the FEE——— [[E—— ———
profile name. Edit this to the name you
have given your profile.

You can now start Mach4 with a double
click




& Mach4Mill Properties *

. Security Detailz Previous Versions
P rOfI I e (3 ) / General Shortout Compatibility

pt

Change to the General tab _ |
ype of file:  Shortcut (Ink)

/ Description:  Mach 4 CNC GUI

Location: C:3Users'win10userDesktop

Replace the name with
your profile name.

Size: 152 KB {1,561 bytes)
Size on digk:  4.00 KB (4,056 bytes)

Created: Frday, June 2, 2023, 11:32:30 AM

Modified: Frday, June 2, 2023, 11:32:30 AM

Accessed: Today, June 2, 2023, 11 minutes aga

Mtibutes: | Readonly [ Hidden Advanced...

Cancel Apply




Mach4 Install

* | & < | Downloads

- He Se V
Flnd the Insta” flle. <« A * > This PC » Downloads &

~

Search Downloads

Mame Date maodified Type Size

3+ Quick access

Double CIiCk it w v Yesterday (1)
% MachdHobby_Installer-4.2.0.5036 6/1/2023 5:59 PM Application 20,758 KB
; Downloads —w Y. PP

|if'| Decuments

&= Pictures
J‘! Music
m Videos

@ OneDrive

= This PC
3 ' 3D Objects
[ Desktop
|if'| Documents
; Downloads
J‘! Music
&=/ Pictures
m Videos
e 0S(C)
== USE Drive (D)

1item




Mach4 Install

Check to accept license
terms

Click Next —

&, MachdHobby CNC Software Version 4.2.0 Build 5036 Setup —

License Agreement
Flease review the license terms before installing Mach4Hobby CHNC Software Version
4,2.0 Build 5038 .

Press Page Down to see the rest of the agreement,

X

—- Wotice of Lighility —-—

Itis the nature of all machine tools that they are dangerous devices. In order to be

permitted to
run Mach4 on any machine you must agree to the following:

I agree that no one other than the owner of this machine will be, under any
drcumstances, responsible for the operation, safety, and use of this machine. I agree
there is no situation under which I would consider ArtSoft or any of its distributers to be
responsible for any losses, damages, or other misfortunes suffered through the use of

\agreement to install Mach4Hobby CNC Software Version 4. 2.0 Build 5036 . Click Mext to
continue,

|} i :
@ the terms of the License Agreement;

W

If you accept the terms of the agreement, didk the check box below. You must accept the

‘bl Next > | Cancel
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Mach4 Install

Observe the warning
message!

Click Next

&, MachdHobby CMC Software Version 4.2.0 Build 3036 Setup — >
Choose Install Location
Choose the folder in which to install Mach4Hobby CMC Software Version 4. 2.0 Build 'ﬁ

5036 .

HIWWARNING!
™. Unless you are very familiar with Mach4 and absolutely certain you do not want to install in

the default location {C:\Mach4Hobby) for some reason, GO WITH THE DEFALULT and save
yourself some grief.

Destination Folder

| C:\Mach4Hobby| Browse...

Space redimeaed=0.4 MB
Space available: 197,050

< Back Cancel

12



&, MachdHobby CNC Software Version 4.2.0 Build 5036 Setup = 4

Mach4 Install Choose Components
Choose which features of Mach4Hobby CMC Software Version 4.2.0 Build 3036 you .."j.'
want to install,
U nCheCk type Of Chedk the components you want to install and unched: the components you don't want to
using. = B
Select Machine Control Types Lathe Desaription
L] I - ~ J
Click Install Bl
B Vil _6Ais)
|:| Router
[] Tangential
[] Plasma
Space reguired: 348.6 MB

< Back Install Cancel




Mach4 Install

Wait for progress bar

& MachdHobby CNC Software Version 4.2.0 Build 5036 Setup

Installing

Please wait while Mach4Hobby CMNC Software Version 4. 2.0 Build 5036 is being

installed.

S

< Back

Next >

e

Cancel




Mach4 Install

Click Finish

@) MachdHobby CNC Software Version 4.2.0 Build 3036 Setup —

Completing Mach4Hobby CNC
Software Version 4.2.0 Build 5036
Setup

Congratulations! Mach4 has been successfully installed on
your computer.

=*=Tt is highly recommended that you use the loader to
COPY one of the default profiles (saving it as something
unique) and configuring the newly created profile for your
machine, ***

[]iets get started, launch the Mach4 Loader now.

15



Mach4 Install

Mach4 will start and
show the profile select
screen.

Select Your profile then
Copy

Click OK

Select Profile

Current Profiles

MachdlLathe
Machabdill
Machdbill_tlxis
—p oK

Create Praofile

Copy Profile

Restore Backup

Delete Profile

Import Profile

Cancel

16



Screen Set

Mach4 has a built in screen editor

You may use it to modify any part of a screen

You may add or remove buttons.

You may change colors or type fonts.

You may add controls.

Screens can be fully customized, but start with one of the pre-built screens

You may switch screens at any time during operation.

17



Mach4 Install

Copy profile will ask for
screen choice.

Select wxLathe set for
Lathe

Click “Open” ——

Select the screen set...

A « Mach4Hobby » Screens v D Search Screens
Organize - Mew folder 15w
& OneDrive ~ Mame Date medified
| Blank.set 8/8/2019 10:42 AM
[ This PC L] Blanks "~ -
T ) | ] Engrave_Marking.set 1/17/2020 5:39 PM
-3 3D Objects [ wocd.set 12/16/2022 2:05 PM
B Desktop R e — 12/16/2022 2:05 PM
= D t - T}rpE: SET File 08N e
= Yocuments u wih gi-e 2,99 ME 9/28/2022 10:06 PM
; Downloads Date modified: 12/16/2022 2:05 PM
J‘& Music
= Pictures
m Yideos
e O5(C)

File name: |wxd.set Screen files (*.set)

m @
Type

SET File
SET File
SET File
SET File
SET File

Cancel



Mach4 Install

As Mach4 Starts it will
try to use some internal
network functions.

Windows will show this
block warning.

This will only happen
on the first time start

up.

@ Windows Security Alert

@ Windows Defender Firewall has blocked some features of this
app

Windows Defender Firewall has blocked some features of Mach 4 CNC GUI on all public and
private networks,

@ Mame: ach 4 CMC GUI
. Publisher: Mewfangled Solutions

Path: C:ymach4hobbymach4gui.exe

Allow Mach 4 CMC GUT to communicate on these networks:
[ ]Private networks, such as my home or work network

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have lite or no security)

What are the risks of allowing an app through a firewall?

Allow access

e ——

— Gg.]lnw aCCess Cancel
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Mach4 Install

@ Mach 4 - Hobby - X
File View Configure Diagnostic Wizard Operater Help

Program Run = Turn Cycles

SUCCESS! Mach4 |[scoe woi
is installed.

Before we can run
we needtoinstalla VY

plugin for motion SR -6.2124
control. L 0.6556 [l |"

Cur. FIX Spin. Ranue

(Gh4

_ = : ;':V| File Ops | Run Ops | Tool Path Ops Jogaing
"

Current Tool #

Stop Mach4 with [l -

the X B

£ Type here to search i QR 2 ; 2°F Heavy rain



Mach4 Install

Mach4 will build a
screen icon for each
machine type you
selected.

Convert one of them to
be your profile.

Right click on the icon
and select Properties

& MachaMill Properties

Security Dletails
General Shorteut

.@ Mach4Mil
7

Target type: Application

Target location: Mach4Hobby

Previous Versions
Compatibility

—

Target: “MachdHobby\MachdG Ul exe /p

Start in: |C:'-.I'\"Iach4H0hb:.'

Shortcut key: |None

Bun: Momal window W
Comment: |Launch Profile |
Open File Location Change Icon... Advanced...

Carca | [0

Change the profile name to
the profile you created.

21



Mach4 Install

Change to the
General tab

Change the name to
your profile name

Click OK

The desktop icon will
now start Mach4 with
your custom profile.

& MachdLathe Properties

Security Details Previous Versions
General Shortcut Compatibility

=

| Mach4Lathe

Shortcut (Ink)
iption:  Mach 4 CNC GUI

C:\Users'win10user'Desktop
Size: 1.52 KB (1,565 bytes)
Size on disk:  4.00 KB (4,096 bytes)

Created: Thursday, July 20, 2023, 11:25:38 AM
Modified: Thursday, July 20, 2023, 11:25:38 AM
Accessed: Today, August 6, 2023, 2 minutes ago

Atributes:  []Read-only [[] Hidden

Advanced...

22



ESS- Ethernet Smooth Stepper

The motion control- ESS- requires a software driver, called a plugin.
It is supplied on the memory stick with this system.

To check for a newer version look at https://warp9td.com/

Download the .zip file ESS_Mach4 v298.zip
298 indicates the version number.

Open the .zip file and copy the two files

23


https://warp9td.com/

ESS plugin install

Pinto Quick Copy Paste

Using File Explorer navigateto =
c:\Mach4Hobby\Plugins S
Paste the two files into this g

folder ”

Mach3
. Mach4Hobby
Warp9Mach4.sig perfLogs
Program Files
Warp9Mach4.m4pw e
gramData
scratchdir
Users
WCH.CN
Windows
& 178 (Dv)

== DVD RW Drive (E:)

;i J dhy ut
= |

w- Copy path
[7] Paste shortcut

EE| x -J;;

Copy Delete Rename
to~ -

Organize

» ThisPC » Windows (C:) » MachdHobby » Plugins

-~

Mame

7 IuaS3.dil

| mcKeyboard. mdpw
| mcKeyboard.sig

| mclua.mdpw

| mcLua.sig

| mcModbus.mdpw
| mcModbus.sig

| mcRegfile.mdpw

| mcRegfilesig

| mcSerial.mdpw

| mecSerialsig

| mecSurfaceMap.mdpw
| mcSurfaceMap.sig
| meXBaox.mdpw

| mcXBox.sig

| meXheMpg.mdpw
| meXheMpg.sig

| ShuttlePro.mdpw

| ShuttlePre.sig

New
folder

TLE MEW ILem ~

¥ | Easy access ~

Mew

P
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Mach4 Install

Double click your profile Mach4 icon

When Mach4 starts select the
configure menu bar item

Select Control

& Mach 4 - Demo
File View  Configure Diagnostic Wizard Operator Help

Select Motion Dev... -
Program e Mapping Engrave | Trace

ontrol...

— -
Curren Plugins...

. Wachine | Distance )|
| e | | T | I

G Code MDI

25



Mach4 Install

Select the ESS plugin
Click OK
Shutdown Mach4

Restart Mach4 to start the ES
plugin.

Control Configuration MyMill:0

........................

LT= T - - T IR - TR T - " A = e

s
ANAANNEXANAALAL

R,
[ % B

=
[*¥ ]

Enabled

Description

Core - MNewfangled Sclutions

Keyboard Inputs - Newfangled Selutions
LUA - Newfangled Solutions

Modbus - Newfangled Selutions

Regfile - Mewfangled Selutions

Serial - Mewfangled Selutions

Surface Map - Newfangled Solutions

ZBox Controller - DazTheGas and Newfangled
ZhcMpg - Newfangled Solutions

ShuttlePro - Newfangled Solutions
simulator - Newfangled Solutions
WarpRunner v 002 - Warp9 Tech Design, Inc.
ESS w284 - Warp9 Tech Design, Inc.

Version

4.2.0.5036

4.2.0.5036
4.2.0.5036
4.2.0.5036
4.2.0.5036
4.2.0.5036
4.2.0.5036
2.1.3
4.2.0.5036
4.2.0.5036
4.2.0.5036
0.002
1.0.1.284

26



Select Motion Device X
Mach4 Install
Select the motion control device,
WARNING!
Changing the motion control device will destroy any existing
When Mach4 starts select axis to motor mapping and moetor tuning.
Conflgure ..... Simulation Device

Ethernet SmoothStepper

Select motion device
Choose ESS
Click OK

Shutdown Mach4

oK Cancel Apply




ESS Setup [I:]\Qwapssmomh«pp ~Search x| J§ Home x I

https://warp9td.com A e =

ome Product Details Getting Started Help Software

Welcome to Warp9 Tech Design, home of the Ethernet and USB
SmoothStepper motion controllers!

ESS support for Torch Height Control
ESS suppor

for Laser Vectoring and Rastering (pictures)

Backlash Compensation

PID Spindie Contro

Multiple RPM updates per revolution
Lathe Threading

H £ Type here to search i 71 Russell 2000

Browse to https://warp9td.com

Follow the directions to download the SCU application. There is also a great amount of
background on setting up the ESS

- gy VHA9AM

6/2/2023

]
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https://warp9td.com

im| ‘ QO warp9 smoothstepper - Search X [I§ Software x |+ -

L5 ] &) http

E S S S et u p —— V. rp3d _lech design, inc. )

/warp9td.com/index.php/sw A {8 T=

Home Product Details Getting Started Help E: I b Documentation FAQ Forum

Order Distributors Solution Partners Break Out Boards Register for Forum Privacy

Current Software Page
Select the SCU — Which piece of software are you looking for:

. 83°F Sunny




| : ; : ; S etl I @ www.googlecom x | I Software X @ SCUDownloads X & Shared with me - Google Dr X Mach Software for Lathe - G X ‘ + e - X
&« @ { A Notsecure | documentation.warpdtd.com/Software/SCU/01_Download.htm 2 % O @ »0W:

% Bookmarks [E] Google Calendar & Contacts Imported From [E % Photos- Google Ph.. G G Gmail ) Credit Card, Mortga.. @3 (2) Make and Sel B Manage orders awa. » Other bookmarks

WARP 9 a
TECH DESIGN
You may use the SCU Installer download instead of the SCU Lite or Application Only versions above. The SCU Installer will install NET 4 (if it is
e e‘ t t e — Getting Started not currently installed) along with the SCU application. It will then start the SCU so you may configure your computer correctly.
m Download SCU Installer Full v2.0.5.8 (Recommended)

Software

Download SCU Installer Full v2.0.5.2 (Previously Recommended)

Download SCU Installer Full v2.0.2 (Previously Rect )

Scu

Download SCU Installer v2.0.0
SCU (System

Configuration « Download SCU Installer v1.3 (Previously Recommended)

Utility) « Download SCU Installer v1.2 (Qld)

Introduction
Download SCU Installer vi 1 (Old)

SCU Usage
Instructions

SCU Downloads

scu
Troubleshooting

H P Type here to search W 79°F Partly sunny

Browse to https://warp9td.com

Follow the directions to download the SCU application. There is also a great amount of
background on setting up the ESS 30


https://warp9td.com

ESS setup

Find the downloaded file and
double-click on it to run,

31



SCU setup

Start the SCU
Select Language

Select NEXT

Select Setup Language =

i—'-:':-. Select the language to use during the
'E,;:_ installation.

Ehgish P
/

Cancel

f@. Setup - Warp9 Tech Design - 5CU Application —

Information
Flease read the following important information before continuing.

When you are ready to continue with Setup, dick Next.
Thank you for purchasing an Ethernet SmoothStepper (ESS)!
This installer will:

1) Install the ESS's System Configuration Utility (SCU).
2) Launch the SCU, which will configure your computer to communicate with the ESS.

Cancel

32



ESS setup

Use the suggested folder

Select Next to install \

@ Setup - Warp® Tech Design - 5CU Application —

Select Destination Location
Where should Warp2 Tech Design - SCU Application +2.0.5.8 be installed?

Setup will install Warp2 Tech Design - SCU Application v2.0.5.8 into the
following folder.

To continue, dids Mext, If you would like to select a different folder, dick Browse.,

C:'Program Files (x86)Warp2 Tech Design Browse...

At least 6.9 MB of free disk space is reqiied

= Back

Cancel
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ESS Setup

Note the instructions.

Select Next

-.‘"_{;-L Setup - Warp® Tech Design - 5CU Application —

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Mext.
When the SCU starts, it will guide you through:

1) Installing Mach (if you have not done so already).

2) Installing the ESS's plugin for Mach {if you have not done so already).

3) Configuring your computer with “Easy Mode”,

4) Detecting your ESS,

5) Run "Windows Performance Tuning”, so Windows will can run its best with Mach.

34



ESS Setup

Select Finish

ﬁ;._-_' Setup - Warp9 Tech Design - SCU Application

Completing the Warp9 Tech
Design - SCU Application v2.0.5.8
Setup Wizard

Setup has finished installing Warp3 Tech Design - SCU
Application v2.0.5.8 on your computer, The application may
be launched by selecting the installed shartcuts,

Click Finish to exit Setup.

1 aunch Warp3 Tech Design - SCU Application v2.0. 5,8

< Badk Einish
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&4 SmoothStepper System Configuration Utility v. 2.0.5.8 - O X

ESS Setup |~

Thank you for purchasing an Ethernet SmoothStepper (ESS)!

This System Configuration Utility (SCU) will help you install the Mach Software, the ESS Plugin and then configure your Windows PC to
communicate with your Ethernet SmoothStepper (ESS).

MNaotes:
1) Look for the flashing buttons or text, to help guide you.
2) Hover aver buttons for maore information.
3) If you cannot get any communications from your ES5, please check your Ethernet cable and Power Cycle the ESS.
4) This SCU will not work with the USE SmoothStepper (USS)

1: Download Mach (optional) | | 2: Download ESS Plugin [optional) | | 2: Start Pi Configuration

Use option 3 =—
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ESS Setup

Select Easy Mode -~

&2 SmoothStepper System Configuration Utility v. 2.0.5.8 - O X
File Help
Please cheose one of the following to configure your computer:

* Most people will use "Easy Mode', since it will configure everything in 3 mouse clicks! Your SmoothStepper will use the factory default settings
and connect directly to your computer (Most Commen),

* "Wizard Mede' guides you through the setup and configuration process, but requires some networking knowledge.
* ‘Advanced Mode' is for advanced troubleshooting.

Go Back | | Easy Mode | | Wizard Mode | | Advanced Mode

This will help guide you through the configuration process. |

37



ESS Setup

2 SmoothStepper System Configuration Utility v. 2.0.5.8 - X
File Network Adapter Types Help

Step 2: Canfigure Everything:
Clicking on 'Configure Everything' will configure the Network Adapter and Firewall for communications with the Ethernet SmoothStepper.

Refresh Details

Detected Network Adapters

[ 12 Adapteriame [ Type s Status | Bytestt | Mode | Adagterie Adapterinfo

Ethernet 4 Ethernet Down 0 DHCP | 169.254.103.101 Intel(R) Ethernet Connection 121

Click on this adapter”

F Maostly sun




&2 SmoothStepper System Configuration Utility v. 2.0.5.8

File Network Adapter Types  Help
e l lp Step 3; Listening for Ethernet SmoothSteppers :

The ‘Detected ESS(s]' table (st the bottom of this windouw) will update every few seconds with any detected ESS(s), but it may take up to 3 minute for the first ping to show up (if there

n ARP issue)
If your ESS appears choose Windows Performance Tuning from the File menu, If your SmoothStepper does not appear within a minute click on 'l don't see my ESS'

If you see BootP packets coming in, remove the BOOTP (JP1) Jumper from the ESS and power cycle the ESS, otherwise Mach will never be able to connect to the ESS.

| don't see the ESS, Help m Refresh Details

. Detected Network Adapters
eth e rn et Ca b I e IS ID AdapterName Type  Status BytesRX Mode AdapterlP Adapterinfo
| 1_|smoothStepper Network 11| Ethernet | Down [0 |pHee |10, | intel(R) Ethernet Cannection 1219-LM
11 1] Detected ESS(s): If your ESS appears below, choose Windows Performance Tuning from the File menu.
controller “PC port an d »©
1 |esEr7oo0adsc  [109.98 Ethemet  [10892 |22
that the controller is
turned on.

ur ESS.

lick on the network adapter connected toy

Then, select the “Files” , e
drop down box.

7121720




ESS Setup

SmoothStepper System Configuration Utility v. 2052

- X
. Network Adapter Types _Help
[ Easy Mode 1
Wizard Mode
his window) will update every few seconds with any detected ESS(s), but it may take up to a minute for the first ping to show up (if there is an ARD issus).
Advanced Mode

. 7] ' Wi s e s e T ance Tuning from the File menu. If your SmoothStepper does not appear within a minute click on 'l don't see my ESS'
I e I I O rl I la l l Ce I u l l I l lg Bt e BOOTP (IP1) Jumper from the ESS and power cycle the ESS, otherwise Mach will never be able to connect to the ESS.
from the dI"Op down box.

jon't see the ESS, Help m. Refresh Details

Detected Network Adapters

ID AdepterName Type  Stotus BytesRX Mode AdapterlP Adapterinfo
| 1_|smoothStepper Networi 11 |Ethernet | Down |0 |oHCP |10992 | intel(R) Etheret Connection 1219-Lt

Detected ESS(s): If your ESS appears below, choose Windows Performance Tuning fram the File menu,

D AdapterType AdapterlP SuccessfulPings BootPRxd
1 | E&:ET:70:00:A4:8C 10.9.99 Ethernet 109.9.2 163

[ see Pings, open Windows Performance Tuning
p £45PM
H P Type here to search ‘. < .

7/21/202:
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ESS Setup

Follow the instructions as
shown.

&2 Windows Performance Tuning -
Welcome! Let’s talk about how Windows settings can impact CNC operations

This utility can help to optimize a limited set of Windows settings to work more in unison with your CNC. This can avoid issues such as Windows Update, search indexing, your power plan, anti-virus, and virtual
memory from unexpectediy interrupting one of your CNC jobs.

We cannot stress enough that this PC should be dedicated to controlling your CNC and not used as an everyday PC.

However, we recognise that this may be unavoidable and you may need to switch in and out of CNC operations. To allow for this we will make a copy of your current settings. These saved settings will represent
your PC settings when not using your CNC. You would choose "Optimize PC" to use the CNC or "Restore PC” to stop using the CNC. For this scheme to work well, please do NOT change any of the settings we
present to you outside of this utility.

However once again we recommend ONLY using this PC as a dedicated CNC controller.

If you do NOT want us to optimize your Windows settings at all, you can simply close this Window.

Before you continue, please make sure your PC has installed ALL recent Windows Updates by clicking the button below. Once all Windows Updates have been applied and your PC restarted (if needed), please
reopen this utility and continue.

If have already done this, please press Save Settings when you are ready,

Save Settings | ‘ Windews Update

Build Support Log

Ready

£ Type here to search ®

Earnings upcor
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&2 Windows Performance Tuning -

Current Windows settings versus our optimal settings:  SmoothStepper Network Adapter:

The list below represents various windows Control which protocols and services are used and power management
settings that have differences. Simply click the
button below to make all changes. Clicking on a Eatirg Kl H iz BrmEEE H Refresh H Apply Below Actions Only

section will summarize the actions needed for
the specific section. e
- Unused Protocols and Services -
« Turn off Microsoft LLDP Protocol Driver.
« Turn off Link-Layer Topology Discovery Mapper I/Q Driver.
« Turn off Internet Protocol Version & (TCP/IPv6).
« Turn off File and Printer Sharing for Microsoft Networks.
111 « Tumn off Link-Layer Topology Discovery Responder.
Screen Saver « Turn off Client for Microsoft Networks.
elect “apply all

Display Scaling

SmoothStepper Network Adapter

= Power Management -
* Do NOT allow the computer to turn off this device.

r m m n d d t' n ” Power Plan and Options ranced
= Advanced -
eco endea actions . e e

Windows Update
= Restart PC
Windows Search Indexing Options
Performance Options
Microsoft OneDrive
windows Firewall Program Rules
Windows Anti-Virus Scheduled Scan

This will require you you

Windows File and Folder Permissions

restart your PC.
Refresh Settings __Eu\\d Support Log

€ & 79°F Mostly sun

Ready

£ Type here to search
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ESS Setup

After Your PC re-starts,
run the Smooth Stepper
Utility from your desktop,
and you should see this

screen.

Select “Close Window and

SCU”

ESS setup is now

complete.

&2 Windows Performance Tuning

Current Windows settings versus our optimal settings:

Awesome! You appear to be all set!

Close Window and SCU

SmoothStepper Netw

Screen Saver

Display Scalin:

'erformance Options

Microsoft OneDrive

windows Firewall Program Rules
Windows Anti-Virus Scheduled Scan
windows Anti-Virus Real-Time Protection
Windows File and Folder Permissions

Windows GPU Performance Preferences

Refresh Settings

L Type here to search

Ready

Instructions:

Please choose a setting to see more information

Build Support Log
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ESS Setup is now complete
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Machine Configuration

The ESS has 3 ports of 17 pins.

Most pins can be assigned as input or output.

The system has several control signals which are connected to an ESS pin
We must associate each signal with the correct pin.

All this data is stored in the Machine.ini file within your Profile.

There is a Machine.ini file on the memory stick supplied with this system.

You may simply copy it from the stick to replace the current file in your Profile.
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Active Low

All signals in this system are digital, binary.

That means they may be a HIGH (typically +5V) or LOW (typically ground)
The system needs to know when the signal is TRUE, or ACTIVE

Active High means the signal is TRUE when it is HIGH

Active Low means the signal is TRUE when it is LOW.

There is no right or wrong, here, you just must use whichever choice the system
designer chose.
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Machine Configuration

If you want to fully understand the wiring of your machine use the following
screens to configure the ESS pins.

The general process is to assign alias names to the pins in the ESS config and
assign the alias names to the correct functions in Mach4.

The following screens refer to the tabs of the ESS Config screens.
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Machine Configuration

From the main Mach4
screen menu bar

Select Configure-
>Plugins->ESS

Info screen will open

Work across the tabs

@ Ethernet SmoothStepper (ESS) Configuration v285, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle  Laser  Laser.. Analog Pins Config  Input Signals  Output Signals  Heming  Probing  Backlash |

Click here for:  Getting Started: Setting up the SmocthStepper and Machd Please read the Safety Page Warp9TD.com FAQ Warp9Tl

@ WARP9

TECH DESIGN

This plugin recommends using Machd 4612 or newer
Show a waring at startup if Mach4 is clder than that

PLEASE READ! This will help you to set up your ESS (Ethernet SmoothStepper) motion controller plugin.

If you DO have the motion controller board connected, you can freely switch back and forth between this config and Mach's config, and the ch
If you do NOT have the motion controller board connected, do not change settings in Mach's Signals Tabs, Cnly work in this config window,

General Setup Steps:
1) Cenfigure the 'General’ tab and then the 'Motors' tab.
2) Configure the 'Pins Config tab:
* STROMGLY RECOMMEMDED: Use Aliases! It will make it much easier to remember which pins do what.
* Read the Setup Guide for details on Noise Filtering
- If the value is 0, noise filtering will be disabled and the pin's data will not be delayed.
- If you are getting erroneous Limit Switch Hits, add some noise filtering to the limit switches and fix your limit switch wiri
3) Assign pins to your 'Input Signals' tab and to your 'Cutput Signals' tab.
4) Configure the 'Homing' tab.
5) Finally, close this configuration window, and go into the Mach config to finish your systern setup. 48
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ESS Config Tab
General

On the General tab leave
all the settings as is.

\F{d Ethernet SmoothStepper (ESS) Configuration v285, Mach4 build 4.2.0.5036 - Instance

HC

Info General Motors Spindle Laser  Laser.. Analog Pins Config Input Signals Output Signals Homing Probing  Backlash
1) IP Address of the SmoothStepper 2) Buffer Size (seconds, max of 0.5) 3) Plugin Frequency (Hz)
~]  [0a800 | [40
4) Velocity FIFO Buffer Ran Qut of Data 5) Disable & EStop 6] Advanced Logging
[] Show Hardware Velocity FIFO Ran Dry Msgs [ Charge Pump Runs In EStop []Enable Advanced Logging

Disable Expansion Port In Disable

7) When a Feed Hold Event turns an Quput Pin
OFF, prompt the operator before turning the output pin ON again

ON, prompt the operator before turning the output pin OFF again

1) The motion controller's IP address will be 10.9.9.9 unless it was modified with the configurator.

2) Buffer Size defaults to 0.18 A smaller buffer size is more responsive to Feed Hold commands, but is more sensitive to the
Velocity FIFO running out of data if your computer bogs down. Increase the buffer size to prevent the Velocity FIFO from
running out of data. If you have received "Velocity FIFO Ran Out of Data' messages, you should restart Mach4 after
medifying the buffer size,

3) The plugin frequency is typically left at 40 Hz. Higher frequencies will let Mach respond to events faster, but will also force
your PC to work harder to keep up (which is harder for slower computers to do).

4) This lets you choose to watch the Velocity FIFO, to make sure it does not Run Out of Data. We recommend you leave this
checked. Running cut of data may cause lost steps, and may indicate your PC is doing other tasks instead of servicing Machd,

If you get these messages regularly, take these actions so critical data can make it to the motion controller in time:
* Increase your Buffer Size (above).
* Disconnect your PC from the internet and shut off WiFi.
* Shut down all other programs on your PC,
* Decrease your plugin Frequency to 30Hz or 20 Hz (above).
* Visit Warp9TD.com and look at our FAQ Windows page to see how to optimize your PC further.
* If your PC has less than 3 GB RAM (XP), 4GB RAM (Win7) or 8 GB RAM (Win10) you may want to increase your PC's RAM,

OK Cancel
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ESS Config Tab

Motors

We are using
Step/Dir motors
on all positions.

w2 Ethernet SmoothStepper (ESS) Configuration - v260

Info General |

UtUI'S Spindle Laser  Pins Config InputSignals Output Signals

Homing Probing Ba

Axis Motors Settings: Step/Dir, Quadrature or CW/CCW

Maotor 0
Maotor 1
Mator 2
Maotor 3
Motor 4

Motor 3

Mode
Step/Dir
Step/Dir
Step/Dir
Step/Dir
Step/Dir
Step/Dir

Reported Feed Rate Smoothing (Sec)
0.100
0.100
0.100
0.100
0.100
0.100

[JEnable AntiClunk Mode for Servo Motors

1) In the 'Qutput Signals' Tab, assign Aliases or Pins
for each Motor used.

2) In Mach Cenfig -> Motors, set up the parameters
for each Motor used.

3) In Mach Config -> Axis Mapping, Enable your axes
and assign Motors as Masters and/or slaves,
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ESS Config Tab
Spindle

We use a PWM =—
signal to control
spindle RPM.

Do not use PID
terms.

@. Ethernet SmoothStepper (ESS) Configuration v298, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals

Output Signals

Homing Probing Backlash HC

1) Spindle Settings
Spindle Type:  PWM

RPM: | Spindle Encoder A ~ Averaging | 1.00| Sec [~ Report Spindle RPM

2) Spindle PID Settings (Only for PWM Drive Mode)
usePiD 5

55_PID_LOG.csv

Kd

Kp

% of commanded RPM

1) Choose a Spindle Type of:
* Relay or none - The spindle/router is controlled by relays or there is none
* OB - Out of Band (Step/Dir, CW/CCW or Quadrature)
* PWM - Pulse Width Modulation Spindle Speed control

The "Output Signals’ tab has dedicated Spindle pins for your system’s relays:
* Spindle Dir - Retains the current spindle direction even when the spindle stops.
The state changes only with a direction change (prevents direction glitching)
* Spindle On - Active when the spindle is active
* Spindle Fwd - Only active when the spindle is running forwards/CW
* Spindle Rev - Only active when the spindle is running in reverse/CCW

2) Spindle PID will adjust the PWM output, to try and hold the commanded RPM.
* Kp is the constant propertional gain that comrects for the error amount.
* Ki corrects for the error amount summed over time.
* Kd comects based upon the rate of change of the error amount.
* Recommended initial values are Kp = 0.0000100 Ki = 0.0000000 Kd = 0.0000000
* Index Pulses per Rev is '1° unless a slotted disk or enceder channel is used.

3)in the "Output Signals’ Tab, assign Aliases or Pins as needed for:
* Spindle Moter PWM (Required)
* Spindle Motor Dir (Optional)
* Spindle On (Opticnal)
* Spindle Fwd (Optional)

| Frequency, Hz: |300.00 | [JDuty Cycle Zero at Min RPM

Encoder Prescaler| 1078 | * Effective PPR | 1 = | 1078 Total Encoder Pulses/Rev
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ESS Config Tab
Pins Config

Scroll down on the
Pins tab to see
the Port 2
assignments.

Enter alias names
for these pins.

Info General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals OutputSignals Homing Probing Backlash HC
1) Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
2) Give the Pins you are using an Alias: {P#-2} DESCRIPTION (This is the {Port®-Pin#} for the pin and a descrption of it) .
This makes it MUCH EASIER to identify which pins do what in the Input and Output signal tabs.
3) Assign Noise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Hold or Stop (Stop, EStop, Disabled or Limit) event can set theQutput state to 'Force ON', Force OFF, or 'No Change'.
‘Mo Change' means that the output is controlled by Machd, With 'Force ON' and 'Force OFF' the ESS will force that desired state.
5) Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Output signal tabs.
Port 2 Pins 2-9 Direction Port 3 Pins 2-9 Direction
@ Inputs O Outputs @ Inputs O Outputs
This is the tooltip text...
DIR Active High/Low Alias or Name Noise Filtering Stop State Feed Hold State A
Port1-Pin1 Out T Motord step{P1-1} - Me Change Me Change
Port1-Pin2 Out ? Motor O step {P1-2} |- Mo Change Mo Change
Port1-Fin3 Out i Meter 0 Dir{P1-3y |- Mo Change Mo Change
Port1-Find Out ? Motor 15tep {P1-4y - Me Change Me Change
Port1-Pin5 Out T Metor 1Dir{P1-5y |- Me Change Me Change
Port1-Pinb Out T Motor 2 Step{P1-6} |- MNo Change Mo Change
Port1-Pin7 Out ? Motor 2 Dir{P1-7y  |==e- MNe Change Mo Change
Port1-FPin8 Out ? Motor 3 Step{P1-8}  |--=-- MNe Change MNe Change
Port1-Pin9 Qut ? Motor 3 Dir{P1-9y |e-=e- MNe Change MNe Change
Port1-Pin10 In l Estop {P1-10} 000 e e
Port1-Pin11 In 4 Motor 0++{P1-11} (1
Port1-Pin12 In 4 Metor 1++{P1-12} 000 | e
Port1-Pin13 In 4 Motor2++{P1-13} 000 e e
Port1-Pin14 Out ? Spindle PWM {P1-14}  leeees No Change No Change
Port1-Pin15 In 4 Probe {P1-15} 000 e e
Port1-Pin16 Out 7 SpindleREV{P1-16}] leemen Ne Change Ne Change
Port1-Pin17 Qut £y Metor 4 DirdP1-17H e Ne Chanae Ne Chanae ¥
oK Cancel
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ESS Config Tab
Pins Config

Continue entering
alias names as
per the screen to
the right.

('_{d: Ethernet SmoothStepper (ESS) Configuration w298, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals OutputSignals Homing Probing Backlash HC

1) Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
2) Give the Pins you are using an Alias: {P#-#} DESCRIPTION (This is the {Port#-Pin#} for the pin and a descrption of it] .

This makes it MUCH EASIER to identify which pins do what in the Input and Output signal tabs.
3) Assign Noise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Hold or Stop (Stop, EStop, Disabled or Limit) event can set theOQutput state to 'Force ON', Force OFF, or 'No Change',

‘Mo Change' means that the output is controlled by Machd, With 'Force ON' and 'Force OFF' the ESS will force that desired state.
5) Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Output signal tabs.
Port 2 Pins 2-9 Direction Port 3 Pins 2-9 Direction
®Inputs (O Outputs @ Inputs (O Outputs

DIR Active High/Low Alias or Name Noise Filtering Stop State Feed Hold State

Port1-Fin1s ] ¥ FTODE {F 1= 13} L
Port1-Pin16 Out ? Spindle REV{P1-16} |- Mo Change No Change
Port1-Pin17 Out ? Motor 4 Dir{fP1-17t - Mo Change No Change
Port2-Pin1 Out ? -4 e No Change No Change
Port2-Pin2 In ? {P2-2} Spindle Encoder A L1 ) N e
Port2-Fin3 In ? {P2-3} Spindle Encoder B L1 ) N e
Port2-Pind In ? {P2-4} Spindle Encoder Index L1 ) N e
Port2-Pin5 In T {P2-5} 0w ||
Port2-Pin6 In T {P2-6} 0w ||
Port2-Pin7 In T {P2-7} 0w ||
Port2-Pin8 In T {P2-8} 0w ||
Port2-Pind In T {P2-9} 000 | e
Port2-Pin10 In T {P2-10} 117 N U O
Port2-Pin11 In T {P2-11} 117 U
Port2-Pin12 In T {P2-12} 000 e e
Port2-Pin13 In T {P2-13} 000 e e
Port2-Pin14 Out T P24y - Mo Change No Change
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I E ; E ; CO nfi g I a b f@ Ethernet SmoothStepper (ESS) Configuration v298, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser  Laser.. Analog PinsConfig InputSignals Output Signals Homing Probing Backlash HC

u . 1) Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
P I n S O n I 2) Give the Pins you are using an Alias: {P=-2} DESCRIPTION (This is the {Port#-Pin®} for the pin and a descrption of it) .
This makes it MUCH EASIER to identify which pins do what in the Input and Output signal tabs.
3) Assign Noise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Hold or Stop (Stop, EStop, Disabled or Limit) event can set theOutput state to ‘Force ON', Force OFF, or 'No Change'.
‘Mo Change' means that the output is controlled by Mach4, With 'Force ON' and "Force OFF' the ESS will force that desired state.
5) Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Output signal tabs.
Port 2 Pins 2-0 Direction Port 3 Pins 2-0 Direction
.
Th 1S System does not @mnputs O Outputs  @lnputs O Outputs
. | d | t DIR Active High/Low Alias or Name Noise Filtering Stop State Feed Hold State 2
INClude a coolan e =
Port2-Pin15 In T {P2-15} 000 e e
pu m p Port2-Pin16 Out ? CoolantOn{P2-16y |-=—-- No Change Neo Change
- Port2-Pin17 Out ? Charge Pump{P2-17, |- Mo Change No Change
Port3-Pin1 Out ? L | Neo Change No Change
Charge Pump is a Ford Pz " 2 S e B
Port3-Pin3 In T {P3-3} 000 e e
safety feature Pt | F e N ==
) Port3-Pin5 In T {P3-5} 000 e e
commonly known as a s | T e R e o
Port3-Pin7 In T {P3-7} 000 e e
“watchdog timer”. If s | o T o 0 =
- Port3-Pin9 In T {P3-9 000 e e
Mach4 should crash foruie | o L ol B e S
Port3-Pin11 In T {P3-11} 000 e e
. .
the control logic will iz | ¥ e w__ -
Port3-Pin13 In T {P3-13} [ e
v

shutdown all motion. 54
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ESS Config Tab t'
Pins Config

This shows the
remainder of the Pins
Config Tab

&2 Ethernet SmoothStepper (ESS) Configuration w298, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser  Laser.. Analog Pins Config |nputSignals Output Signals Homing Probing Backlash HC

1) Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
2) Give the Pins you are using an Alias: {P#-2} DESCRIPTION (This is the {Port#-Pin#} for the pin and a descrption of it) .
This makes it MUCH EASIER to identify which pins do what in the Input and Qutput signal tabs.
3) Assign MNoise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Hold or Stop (Stop, EStop, Disabled or Limit) event can set theQutput state to 'Force ON', Force OFF', or 'No Change'.
‘Mo Change' means that the output is controlled by Mach4. With 'Force ON' and 'Force OFF' the ESS will force that desired state.
5) Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Qutput signal tabs.
Port 2 Pins 2-9 Direction Port 3 Pins 2-9 Direction
@ Inputs  OOutputs @ Inputs (O Outputs
DIR Active High/Low Alias or Name Noise Filtering Stop State Feed Hold State ~
Port3-Pin2 In £ {P3-2} 000 e e
Port3-Pin3 In * {P3-3} 000 0 e e
Port3-Pind In F {P3-4} 000 00000 e e
Port3-Pin5 In +* {P3-5} 000 00000 e e
Port3-Pin6 In T {P3-6} 000 e e
Port3-Pin7 In T {P3-7} 000 e e
Port3-Pin8 In T {P3-8} 000 e e
Port3-Pin9 In +* {P3-9} 000 e e
Port3-Pin10 In T {P3-10} 000 e e
Port3-Pin11 In +* {P3-11} 000 e e
Port3-Pin12 In £ {P3-12} 000 e e
Port3-Pin13 In T {P3-13} 000 leeeee e
Port3-Pin14 Out ? P34 e Ne Change No Change
Port3-Pin15 In F* {P3-15} 000 e e
Port3-Pin16 Out ? -6y e No Change No Change
Port3-Pin17 Out ? P e No Change No Change
v
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@ Ethernet SmoothStepper (ESS) Configuration v298, Machd build 4.2.0.5036 - Instance 0

L]
ESS CO nflg I ab Info  General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals OutputSignals Homing Probing Backlash HC

2) An Input Pin (or Alias) may be assigned to multiple Input Signals.

1) When you enable an input signal here, it will automatically be enabled and mapped into Mach,
Input Signals

Mach
Mapping Meoged Cion
E-Stop ESS Estop {P1-10}
Motor 0 Home ESS Motor O++{P1-11}

ESS Motor 1++{P1-12}
ESS Meator2++{P1-13}

Limit switches and el
the E-stop button,
etC Motor 5 Home

Motor 1 ++ Limit
Motor 2 ++ Limit
Motor 3 ++ Limit
Motor 4 ++ Limit
Motor 5 ++ Limit

Motor 3 Home
Motor 4 Home

ESS Motor O++{P1-11}

ESS Motor2++{P1-13}

Motor 0 -- Limit
Motor 1 -- Limit
Moator 2 -- Limit
Motor 3 -- Limit
Motor 4 -- Limit
Motor 5 -- Limit
Motor 0 Index

Matar 1 Index

ESS Motor 0+ +{P1-11}

ESS-only
ESS-onlv

N X N N N N XN XK XA NANKXAXAA E

oK Cancel




ESS Config Tab
Input Signals

Spindle and encoder
input signals

G2 Ethernet SmoothStepper (ESS) Configuration v298, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser

Laser.. Analog Pins Config InputSignals Qutput Signals Homing Probing Backlash HC

1) When you enable an input signal here, it will automatically be enabled and mapped into Mach.
2) An Input Pin (or Alias) may be assigned to multiple Input Signals.

Encoder 3 Fhase B

Encoder 4 Phase A

Encoder 4 Phase B

Encoder 5 Phase A

Encoder 5 Phase B

Encoder Aux 0 Phase A (MPG or other)
Encoder Aux 0 Phase B (MPG or other)
Encoder Aux 1 Phase A (MPG or other)
Encoder Aux 1 Phase B (MPG or other)
Encoder Aux 2 Phase A (MPG or other)
Encoder Aux 2 Phase B (MPG or other)
Encoder Spindle Phase A

Encoder Spindle Phase B

Spindle Index (RPM Input)

Spindle At Speed

Spindle At Zero

Probe (G31 or G31.0)

Probe 1 (G31.1)

Probe 2 (G31.2)

Probe 3 (G31.3)

THC On (Arc Okay)

]

NN KN XK KAALAKKKNKKNXX XA

Mach
Mapping

Ess=onty
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS-only
ESS

Mapped Pin

{P2-2} Spindle Encoder A
{P2-3} Spindle Encoder B
{P2-4} Spindle Encoder Index

OK Cancel
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ESS Config Tab
Input Signals

There are no

additional changes
to be made on the
“Input Signals” tab

?{C—L Ethermnet SmoothStepper (ESS) Configuration v298, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser Laser.. Analog Pins Config InputSignals OQutput Signals Homing Probing Backlash HC

1) When you enable an input signal here, it will automatically be enabled and mapped into Mach.
2) An Input Pin (or Alias) may be assigned to multiple Input Signals.

Mach

Spindle Index (RPM Input) ESS {P2-4} Spindle Encoder Index
Spindle At Speed
Spindle At Zero
Probe (G31 or G31.0)
Probe 1(G31.1)
Probe 2 (G31.2)

Probe 3 (G31.3)

Enable Mapping Mapped Pin
ENCOOET 3 FNase B [ 1 ESS-ONIY
Encoder 4 Phase A w ESS-only
Encoder 4 Phase B 4 ESS-only
Encoder 5 Phase A w ESS-only
Encoder 5 Phase B w ESS-only
Encoder Aux 0 Phase A (MPG or other) 4 ESS-only
Encoder Aux 0 Phase B (MPG or other) 4 ESS-only
Encoder Aux 1 Phase A (MPG or other) w ESS-only
Encoder Aux 1 Phase B (MPG or other) w ESS-only
Encoder Aux 2 Phase A (MPG or other) w ESS-only
Encoder Aux 2 Phase B (MPG or other) w ESS-only
Encoder Spindle Phase A of ESS-only  {P2-2} Spindle Encoder A
Encoder Spindle Phase B wf ESS-only  {P2-3}Spindle Encoder B
o
4
4
4
4
4
4
o

THC On (Arc Okay)

0K Cancel
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ESS Config Tab |
Output Signals

These outputs drive
the motors.

For a lathe Motor 3
through 4 are not
needed and will not
be used, but it's OK
to have these

defined.

(T; Ethernet SmoothStepper (ESS) Configuration v298, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser Laser.. Analog Pins Config InputSignals Output Signals Homing Probing Backlash HC

1) An Qutput Pin (or Alias) may only be assigned to a single Output Signal.
2) An Qutput Signal may have up to 3 Output Pins (or Aliases) assigned to it:
*'When enabled in this window, only 'Mapped Pin1' will be enabled and mapped into Mach.
* 'Mapped Pin2' and 'Mapped Pin3' will still receive the same Output Signal as 'Mapped Pin1', but will not be referenced in Mach.
~
Enable Mn:;;:::g Pin1 Mapping Fin2 Mapping Pin3 Mapping

Motor 0 Step wf ESS-only  |Motor 0 step {P1-2}

Maotor 0 Dir ef ESS-only | Motor 0 Dir {P1-3}

Motor 1 Step of ES5-only  Motor 1 5tep {P1-4}

Motor 1 Dir of ES5-only  Moter 1Dir {P1-5}

Motor 2 Step of ESS-only | Motor 2 Step {P1-6}

Motor 2 Dir of ESS-only | Motor 2 Dir {P1-7}

Motor 3 Step of ESS-only  Motor 3 Step {P1-8}

Motor 3 Dir of ESS-only  Motor 3 Dir {P1-9}

Motor 4 Step w ESS-only

Motor 4 Dir w ES5-only

Motor 5 Step w ESS-only

Motor 5 Dir w ESS-only

Motor 0 Enable w ESS

Motor 1 Enable 4 ESS

Motor 2 Enable 4 ESS

Motor 3 Enable i ESS

Motor 4 Enable i ESS

Motor 5 Enable w ESS

ESS, XY Feed Rate PWM w ESS-only

- | [ [ L

oK Cancel 59



ESS Config Tab
Output Signals

Spindle and charge
pump outputs.

f{é Ethernet SmoothStepper (ESS) Configuration v298, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser  Laser.. Analog Pins Config Input Signals OutputSignals Homing Probing Backlash HC

1) An Output Pin (or Alias) may only be assigned to a single Output Signal.
2) An Output Signal may have up to 3 Output Pins (or Aliases) assigned to it:
*When enabled in this window, only 'Mapped Pin1' will be enabled and mapped into Mach.
* 'Mapped Pin2' and 'Mapped Pin3' will still receive the same Output Signal as 'Mapped Pin1', but will not be referenced in Mach.
Enable s Pin1 Mapping Pin2 Mapping Pin3 Mapping

Mapping

ESS. XY Feed Rate PWM 4 ESS-only

Laser PWM/XY Vel PWM/AOut1 4 ESS-only

Spindle Motor PWM Or AOut 0 of ESS-only  Spindle PWM {P1-14}

Spindle Motor Dir ef ESS-only | Spindle REV {P1-16}

Spindle On w ESS

Spindle Fwd w ESS

Spindle Rev w ESS

Alarm w ESS

Charge Pump of ESS-only  Charge Pump {P2-17}

Coolant, Flood (M08, M09) of ESS Coolant On {P2-16}

Coolant, Mist (M07, M09) o ESS

Current Hi/Low 4 ESS

Cut Recovery 4 ESS

Digitize Trigger 4 ESS

Dist To Go x ESS

Dwell ¢ ESS

Feed Hold w ESS

Feed Hold Disabled x ESs

F.H. Not Allowed (4720+) 4 ESS

Feed Rate Override 4 ESS

OK Cancel
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ESS Config Tab
Output Signals

There are no additional
changes to the “Output
Signals” tab

{@. Ethernet SmoothStepper (ESS) Configuration w298, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals OutputSignals Homing Probing Backlash HC

1) An Qutput Pin (or Alias) may only be assigned to a single Qutput Signal.
2) An Qutput Signal may have up to 3 Output Pins (or Aliases) assigned to it:
* When enabled in this window, only 'Mapped Pin1' will be enabled and mapped into Mach.
* 'Mapped Pin2' and 'Mapped Pin3' will still receive the same Output Signal as 'Mapped Pin1', but will not be referenced in Mach.
Enable Ma(!\ Fin1 Mapping Pin2 Mapping Pin3 Mapping
Mapping

Feed Hold | 4 ESS

Feed Hold Disabled 4 ESS

F.H. Not Allowed {4720+) 4 ESS

Feed Rate Override w ESS

Feed Rate Override Disabled 4 ESS

FRO Not Allowed (4720+) 4 ESS

GCode Complete (4802+) 4 ESS

GCode Running w ESS

ESS, Is Moving 4 ESS-only

Jog Cont 4 ESS

Jog Enabled 4 ESS

Jog Inc 4 ESS

Jog MPG 4 ESS

Limit Override b4 ESS

Machine Coord b4 ESS

Machine Enabled 4 ESS

Machine Idle 4 ESS

Machine Probing w ESS

Parts Finished 4 ESS

Rapid Rate Override 4 ESS

oK Cancel
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ESS Config Tab
Homing

The motors in this
system do not have
an index signal.

Home operations
approach the switch
at higher speed,
then back off
slowly to make
accurate location.

3

Info  General Motors Spindle Laser Laser.. Analog PinsConfig InputSignals OutputSignals Homing Probing Backlash HC

: @ Ethernet SmoothStepper (ESS) Configuration v298, Mach4 build 4.2.0.5036 - Instance 0

1) Homing is enabled for a Motor 'N', when the 'Input Signals' tab has:
* 'Motor N Home' Enabled with 2 green check.
* 'Motor N Home' has an assigned 'Mapped Pin',

2) If you have encoders with an index pulse, you may enable homing to a motor's index pin by:
* Place a green check in 'Home to Motor's Index Pin',
* Make sure that the index signal is enabled for that Motor.

Mator 0
Motor 1
Mator 2
Mator 3
Mator 4
Mator 5

Home Pin

(Automatically Populated
from 'Input Signals' tab)

Motor 0++{P1-11}
Motor 1++{P1-12}
Motor2++{P1-13}

Rotational Axis After

‘\‘,’e"‘;‘;‘";‘ sz‘h"("g ",j""’“t;:: Motor Index Pin Backoff
o o . (Automatically Populated Move
WEBLY) | Y || 2l from 'Input Signals' tab) {Units)
200 200 ¥ 0.0000
00 00 ¥ 0.0000
200 200 ¥ 0.0000
0 10 ¥ 0.0000
10 ¥ 0.0000
10 10 ¥ 0.0000

This number sets the velocity of the home
move.
20 is a reasonable value for the LMS5100

0K Cancel
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ESS Config Tab

Backlash

We use ballscrews
with near zero
backlash.

Mach4 can
compensate for
backlash when it
exists.

Leave these values
unchanged.

W3 Ethernet SmoothStepper (ESS) Configuration - w260

Info  General Motors Spindle Laser

Pins Config Input Signals Output Signals Homing Probing Backlash HC

1) Backlash Compensation Options

[Jize Backlash Compensation

¢ []5how Backlash Comp Messages in Log

Motor 0
Motor 1
Motor 2
Motor 3
Motor 4

Motor 5

Enabled

A A A A A A

Backlash
Amount
(Read Only)

0.0000

0.0000

0.0000

0.0000

0.0000

0.0000

Mach
Velocity
(Units/Min)

501.0000
502.0000
125.0000
5000000
15.0000

15.0000

Mach

Use Custom

Acceleration
(Units{Sec"?)

20.0000
20.0700
5.0200

20.0000
10.0000
10.0000

Values?

1) When 'Use Backlash Compensation is enabled, the SmoothStepper will perform Backlash Compensation (B.C).
Fixing backlash through software is never as effective are removing backlash with better hardware,

Custom
Velocity
{Units/Min)

10.0000

10.0000

10.0000

10.0000

10.0000

10.0000

*The first column, 'Enabled’, should be CHCKED if it is a nermal motion axis, or if you want that moter's movements to affect B.C.

Custom

Acceleration
(Units/Sec*2)

1.0000

1.0000

1.0000

1.0000

1.0000

1.0000

63




Associating ESS and Mach4 connections.

We have now assigned a name to each signal connected to the ESS
Now we need to use these names to configure Mach4.

In the ESS we simply refer to motors 0-6.

Mach4 needs to associate a motor with an axis.

Select Configure->Control from Mach4 main screen.
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Configure Mach4 signals- Motors

File View Configure Diagnostic Wizard Operator Help

Each motor must be

G Code | MDI

configured for step
. Contrel Cenfiguration Mach4dLathe:0 X
per unit and speed. ] oo i g i s e

=z

g g
g3

R v N

The motors
maximum velocity is
set here.

oooogEd
fsizig

Test these values

eed Hol e | [ Counts Velocity ~ Acceleration Enable
Ca re u y O e S u re Per Unit Units/Minute  Units/(Sec*2) G Force Backlash (Units) Reverse?  Delay (ms)
N 101445000 |[ 500 |[2000 0.05120381 | [ 0.0000 | O [e
e

you are not pushing
the machine too fast.




Configure Mach4 signals- Motors

On the prototype machine we found these values
Axis Step Vel Accel

X 101445 200 10

Z 8130 200 15

You should make accurate measurement by commanding a set distance and
measuring the actual move.
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Configure Mach
Aux Positions

Enable each motor
and associate the
Axis with motor.

Control Configuration Mach4Lathe:0

X

Defaults General Plugins Motors Aux. Positions  Axis Mapping Heming/Softlimits Input Signals Output Signals  Analog Inputs  Analog Outputs  MPGs | * | *

Motor0
Motor1
Motor2
Motor3
Motord
Motor5
Motor6

xxxuxkxi

Motor7

10000.000000
10000.000000
10000.000000
10000.000000
2000.000000
2000.000000
2000.000000
2000.000000

Enabled | Encoder | Counts Per Unit Updates Planner

oK Cancel Apply
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Configure Mach
Axis Mapping

Enable each motor
and associate the
Axis with motor.

Note Mach4 supports
slave motors when
one motor is not
powerful enough for
an axis (large routers)

Control Configuration Mach4lathe:0

Defaults  Ger

neral Plugins Motors

Aux,

. Positions

Axis Mapping  Homing/SoftLimits Input Signals OutputSignals Analog Inputs Analog Outputs MPGs | * | *

X(0)
Y
@
A(3)
B (4)
(40
0B1(6)
0B2 (M
0B3 (8)
0B4(9)
0B5 (10}
0B6(11)

Enabled  Master

| .

Motor2

B g 0 B % B B KA K

Slave

1

Slave 2 Slave 3

Slave 4 Slave 5

oK

Apply
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Defaults General Plugins Motors Aux. Positions Axis Mapping Homing/SoftLimits Input Signals  Qutput Signals Analog Inputs  Analog Qutputs MPGs ¢ | *

Input Signals I s e T

Input #1

A

:
.
:

Input #2
Input #3
Input #4
Input #5

Associate input pins o

Input #7

with motors home e

.o Input #10
position ot
.
Input #12
Input #13
Input #14
Input #15
Input #16
Input #17
Input #18
Input #19

B 8 8 N N N B B B N N N N N N NN NNKN
A A A A A A AAAAAALAAAARAAAA

Input #20

0K Cancel Apply




Control Configuration Mach4lathe:0 x

Defaults General Plugins Motors Aux. Positions Axis Mapping Homing/SoftLimits InputSignals Output Signals AnalogInputs  Analog Outputs MPGs |4 | *

|
%
:

Input Name

:
d
%

User Description

Configure Mach #
Input Signals o

Motor 1 Home

ESS Motor 0++{P1-11}
ESS Motor 1++{P1-12}
Motor 2 Home ESS Motor2++{P1-13}
Motor 3 Home
Motor 4 Home

Scroll down to Motor i

Motor 6 Home

Home area of the sheet Mot Tame

Motor 8 Home

and make these Motar 9 Home

Motor 10 Home
changes. e
Motor 12 Home
Motor 13 Home
Motor 14 Home
Motor 15 Home
Motor 16 Home
Motor 17 Home

Motor 18 Home

WO NN NN NN NN NN NN NN KA KA K
BN K K K N K N K X K K KK KK KK KKK
A A A A AAAAAAARAASRAH®ASAH®ASRA.H®.SHAHA&

Motor 19 Home

0K Cancel Apply




Configure Mach
Input Signals

Scroll down to Motor++
area of the sheet and
make these changes.

Control Configuration Mach4Lathe:0

Defaults General

Plugins Motors

Aux, Positions  Axis Mapping Homing/SoftLimits

Input Signals

Qutput Signals Analog Inputs  Analog Outputs

bt

MPGs |[*]|*

Motor 0 ++
Motor 1 ++
Motor 2 ++
Motor 3 ++
Motor 4 ++
Motor 5 ++
Motor 6 ++
Motor 7 ++
Motor 8 ++
Motor 9 ++
Motor 10 ++
Motor 11 ++
Motor 12 ++
Motor 13 ++
Motor 14 ++
Motor 15 ++
Motor 16 ++
Motor 17 ++
Motor 18 ++
Motor 19 ++

Motor 31 Home |

P K B N X N X KKK X KX K KKK KA KR

Mapping Enabled

Device

ESS

ESS

Input Name

Motor 0++{P1-11}

Motor2++{P1-13}

Active Low  Log Enabled

P8 B B0 B N B B O OB N N N NN NN XNANAR

VA A A A A A A AAAAAAAAAAAALARA

User Description

OK

Cancel

Apply
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Configure Mach
Input Signals

Scroll down to Motor—
area of the sheet and
make these changes.

1

g Control Configuration Machdlathe:0

X

Defaults General Plugins Motors Aux. Positions Axis Mapping Homing/Softlimits InputSignals  Qutput Signals  Analog Inputs  Analog Outputs MPGs 4 | *

Motor 30 ++
Motor 31 ++
Motor 0 --
Motor 1 --
Motor 2 --
Motor 3 --
Motor 4 --
Motor 5 --
Motor 6 --
Motor 7 --
Motor 8 --
Motor 9 --
Motor 10 -
Motor 11 -
Motor 12 -
Motor 13 -
Motor 14 -
Motor 15 -
Motor 16 -
Motor 17 --

KON N KON NN N NN N NN NN NAANKN K

Motor 18 -

i
i
:

ESS

Input Name

Motor 0++{P1-11}

Active Low  Log Enabled

B B N N XN XN X N KK NN N NNXNXXNXNKY
A A AAAAAAAAAAAAAAAAAANA

User Description

0K

Cancel

A

Apply
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Configure Mach
Input Signals

Scroll down to Index
(Encoder) area of the
sheet and make these
changes.

Control Configuration MachdLathe:0

Defaults General Plugins Motors Aux. Positions Axis Mapping Homing/SoftLimits Input Signals Qutput Signals  Analog Inputs  Analog Outputs  MPGs |

*

3

Maotor 3U --
Motor 31 --
Digitize
Index

Limit Override
E-5top
THC On
THC Up
THC Down
Timing

Jog X+

[ 8g B % 5 % % X % X X X X X % A A X A X X A

Mapping Enabled  Device

ESS

ESS

Input Name

{P2-4} Spindle Encoder Index

Estop {P1-10}

>

PR OB N N N N N N N NN NN NNKNNXR

ctive Low | Log Enabled

VA A A A A AAAAAAAAAMLAAAAALAR

User Description

oK

Cancel

Apply

~
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Configure Mach
Input Signals

There are no more
changes to be made to
“Input Signals”

Note that there are 127
inputs available within
Mach4 software.

1

4 Control Configuration MachdLathe:0

Defaults General Plugins Motors Aux. Positions

Axis Mapping Homing/SoftLimits Input Signals  Qutput Signals Analog Inputs Analog Outputs MPGs | 4 | *

i
i
:

S
Input #107
Input #108
Input #109
Input #111
Input #112
Input #113
Input #114
Input #115
Input #116
Input #117
Input #118
Input #119
Input #120
Input #121
Input #122
Input #123
Input #124
Input #125

BN X K X N X X N XXX XX KKK XK X!

Input #126
Input #127

Input Name

:
g
&
E

Nﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂi_

A A AAAAAAAAAAAAAAAAARA:!

User Description

0K

Cancel

Apply
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Configure Mach
Output Signals

There are no changes
to the “Output Signals’
tab

Control Configuration Mach4Lathe:0 *

Defaults General Plugins Motors Aux. Positions Axis Mapping Homing/SoftLimits Input Signals Cutput Signals  Analog Inputs  Analog Outputs MPGs |4 | *

X++

X Home
Y ++

Y Home

I++

Z Home

A++

A Home

B++

B Home
C++
i
CHome
Enable #0
Enable #1

Enable #2

Mapping Enabled Device  Output Name | Active Low Log Enabled User Description L

Akauuuuuuuuxuuuuuuuu[l

KO KKK KK KKK KK KKK KKK XK
A A AAAAAARAAARA LA A AHA A A HAHA HA-A

oK Cancel Apply
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Configure Mach
Tools

These values are
appropriate for a
lathe.

Control Configuration Machdlathe:0

Aux. Positions  Axis Mapping Homing/SoftLimits Input Signals Output Signals Analog Inputs  Analog Outputs  MPGs  Tools  Spindle Tool Path =L
Max Tools Tool Skip Group
99 (®) Current Group
Tool Change Type O Specified
(O Ton M6 line is next tool Tool Exchange Reset Signal
(®) Ton M6 line is tool to use. (®) Clears specified group.
Tool Life Cancel Number O Clears all groups.
| 100 | Life Count Override (time only)
(® Disabled
Tool Life Restart M Code O Enabled
[ T eoecpreacondiion
Tool Life Type Default (® TLCHB signal is not output.
@ Cycle (O TLCHE signal is output.
OTime TLCHB Signal
(®) Qutput for each tool.
(O Output for the last tool in a group.
oK Cancel Apply
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Configure Mach
Spindle

ontrel Configuration MachdLathe:0 X
S t M . d M Aux. Positions  Axis Mapping Homing/SoftLimits Input Signals Output Signals Analog Inputs  Analog Outputs MPGs  Tools  Spindle  Tool Path 2 [
e a I n a n aX MinRPM | MaxRPM | Accel Time | Decel Time  FeedBack Ratio Reversed Lo
d f th I th o poo 50000 200 200 1.00000 w
Spee or e latne. W o 50000 |2.00 200 1.00000 x
/ 2 ; 0.00 0.00 0.00 1.00000 x
. 3 I 0.00 0.00 0.00 1.00000 ¢
ThIS Value mUSt be Set 4 0.00 0.00 0.00 1.00000 4
5 ! 0.00 0.00 0.00 1.00000 4
to O 6 : 0.00 0.00 1.00000 w
7, ' 0.00 0.00 1.00000 w
000 0.00 1,00000 ¢
These two values must T |
0.00 0.00 1.00000 o
b t h 0.00 0.00 100000 4
€ Setl as snown T Fos ¥
0.00 0.00 1,00000 ¢
0.00 0.00 1.00000 4
The Iathe haS nO belt 0.00 0.00 1.00000 4
0.00 0.00 1.00000 w
ranges- 0.00 0.00 1.00000 w
0.00 0.00 1.00000 4 o
Max Spindle Maotor RPM: ‘ 3600.00 I [ Wait on spindle to stabilize to ‘ 90 5| percent.
Spindle Override Delay: | 25 ‘(msl
L Step/Dir Spindle Axis: | None ~ | (Axis must be enabled and mapped.)  [[] Enable Step/Dir Spindle rigid tapping.
Set MAX spindle RPM
OK Cancel Apply




Generating a Mach4 license key

Mach4 is licensed software.
A license is needed for each machine.
The license is keyed to the PC it is running on.

Each system in this project was provided with a registration code that is needed to
activate a license.
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Generating a Mach4 license key
Click Help->About on the Mach4

menu bar

Copy this PC ID to clipboard.

On the Machsupport.com site
paste the ID when asked.

A key file will be E-mailed to you.

About >

Mach4 Demo - CNC Control Software
5036 Unlicensed

Version: 4.
Build: 5086

For sugfort with this version, please contact:

M| MCH-106F3160-A133-DAFT-BCOA-D53CC5714648

i Copy ID T Cliphoard

Logd License File

For more information, please visit our webpage: www.machsupport.com

Load it here. —

DEMO will be changed after
license is installed.

Support email address: suppot@machsupport.com

2 Copyright 2001-2019
J Mewfanged Solutions, LLC,
Tl BN OF NEYRRLED KON All rights reserved.

0K 79




Mach4 license

After the license key is successfully loaded Mach4 will change references to DEMO
to your user ID.

There are some restrictions built into Mach4 DEMO that will be removed after the
license is installed.

Certain changes to the PC, replacing hard drive or net card, will change the PC_ID

This will require getting a new key from Machsupport.com
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Backup

Mach4 stores all configuration values and some current operation data in a file
C:\Mach4Hobby\Profiles\MyLathe\Machine.ini.

This file is saved during shutdown.

A copy is also stored in the folder \Backups in the Profile folder.

A revolving list of 20 backups are saved with a 2 digit number appended.

If you ever have a problem and want to go back to a previous version simply move
the file from \Backups to replace the current \Machine. ini, removing the 2
digit number.
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Calibrating Spindle Speed

The spindle speed is controlled by a PWM signal
generated by Mach4.

A circuit on the C82 control board converts this
pulse stream to a varying DC voltage between 0 and
+10 volts.

Set the machine ro run at its mid-speed, #### RPM

speed.

Adjust this pot to set the speed.




Spindle Direction control

The C82 board has outputs for Forward
and Reverse run of the spindle motor.

There are two common schemes for
managing these signals, one commonly
used in the US, another in Europe.

The C82 board has two jumpers to set
this.

If set to INT the motor will only run in one
direction.

For this control the=fe ScteHsese
to the US position.
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Congratulations

You should now be ready to make parts with your new Lathe.

Good Luck!
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